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Features

• Access and control multiple multi-platform computers from a single console

• Hot-swappable: disconnect and reconnect computers without rebooting

• Auto-scan: with variable time interval

• Compact design: 1U rack mountable 

• Easy port selection using (1) On Screen Display (OSD), (2) front panel pushbuttons or 

(3) keyboard hotkeys key sequences

• Expandable: control up to 256 computers by adding additional KVM switches

• Simple cable management: use standard Cat5e patch cord (maximum distance 33ft) to 

connect to each computer

• Multi-platform: supports PS/2 and USB computers/servers

System Components

The NetCommander Cat5 KVM system consists of:

• NetCommander Rackmountable Cat5 KVM Switch (Model B072-016-1 or B072-008-1) 

• NetCommander Server Interface Unit - PS/2 (Model B078-001-PS2)*

- USB (Model B078-001-USB)*

• Cat5e Cable (models N105, N001 or N002 series cables)*

• RS232 Serial Cable (provided with KVM Switch)

* Sold separately

Compatibility
The KVM is compatible with:

• PS/2 and USB computers/servers

• VGA, SVGA, or XGA monitors

• DOS, Windows (3X, 9X, 2000, NT4, ME, XP, 2003 Server) LINUX, UNIX, QNX, SGI, 

FreeBSD, BeOS, Open VMS, Novell 3.12-6, Alpha UNIX, HP UX, SUN
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Configuration
Figure 1 illustrates the basic configuration of the KVM system.

Figure 1 The KVM system configuration 

Figure 2 shows the front of the 16 port KVM (Model B072-016-1). The 8 port version

(model B072-008-1) is the same but with only 8 sets of LEDs.

Figure 2 NetCommander KVM front panel

Figure 3 shows the rear of the 16 port KVM (Model B072-016-1). The 8 port version (model

B072-008-1) is the same but with only 8 computer ports.

Figure 3 NetCommander KVM rear panel

Front Panel

Rear Panel

SIU = Server Interface Unit
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Installation

• Switch off all computers

• Ensure that the cables are not close to any sources of electrical noise interference such as 

fluorescent lights, HVAC systems or motors 

• Ensure that the distance between any computer and the KVM switch does not exceed 33 ft.

Connect each computer to the KVM using a Server Interface Unit (SIU) and Cat5e patch

cable (for best results, use STP cables—N105 series). Figure 4 illustrates the connection

options.

Figure 4  NetCommander KVM system connections

NetCommander Server Interface Unit (SIU)

The NetCommander Server Interface Unit

The Server Interface Unit gets its power from the connected computer. In the case of the

NetCommander PS/2 Server Interface Unit (B078-001-PS2), the power is drawn from the

keyboard port. In the case of the NetCommander USB Server Interface Unit (B078-001-

USB), the power is drawn from the USB port.

Connecting a NetCommander PS/2 Server Interface Unit (B078-001-PS2)

To connect the PS/2 Server Interface Unit:

1. Connect the VGA connector to the computer's Video card.

2. Connect the PS/2 Keyboard connector to the computer's Keyboard port.

3. Connect the PS/2 Mouse connector to the computer's Mouse port.

Pre-Installation Guidelines

Connecting the NetCommander KVM System
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Figure 5 NetCommander PS/2 Server Interface Unit

Connecting a NetCommander USB Server Interface Unit (B078-001-USB)

The USB Server Interface Unit supports Windows 98 SE and later, MAC, SUN and SGI. 

To connect the USB Server Interface Unit:

1. Connect the VGA connector to the computer's Video card.

2. Connect the USB connector to the computer's USB port.

Figure 6 NetCommander USB Server Interface Unit

Connecting the Console

1. Connect the VGA monitor to the KVM's HD15 Monitor port.

2. Connect the PS/2 keyboard to the KVM's MiniDIN6 Keyboard port.

3. Connect the PS/2 mouse to the KVM's MiniDIN6 Mouse port.

Connecting the Cat5e Cables

1. Connect one end of the patch cord to the RJ45 port on the Server Interface Unit.

2. Connect the other end to the chosen RJ45 port on the KVM.

3. Do this for each computer.

Installation (continued)

SIU = Server Interface Unit

SIU = Server Interface Unit
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1.  Plug in the KVM. Use only the power cord supplied with the unit.

2.  Switch ON the computers. 

To reset the KVM switch, press both Select buttons on the front panel simultaneously. The

Server Interface Units are unaffected by this reset.

Ambient Operating Temperature

The ambient operating temperature in the rack may be an issue and is dependent upon the

rack load and ventilation. When installing in a closed or multi-unit rack assembly, make sure

that the temperature will not exceed the maximum rated ambient temperature.

Airflow

Ensure that the airflow within the rack is not compromised.

Circuit Overloading

When connecting the equipment to the supply circuit, consider the effect that overloading of

circuits might have on over-current protection and supply wiring. 

Reliable grounding of rack-mounted equipment should be maintained.

Use the L-shaped brackets and screws provided to mount the KVM in a server rack as 

illustrated below.

Installation (continued)

Connecting the Power Supply

Resetting the KVM Switch

Rackmount Considerations

Rackmounting the NetCommander KVM

Figure 7 Connecting the L-shaped bracket
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To cascade two or more NetCommander KVM switches, follow the connections in the figure

below. 

Setting the different OSD display hotkeys is explained on page 11.

Figure 8 Cascading NetCommander KVM switches

Switch between the connected computers using any of the following methods: 

• The OSD (On Screen Display) 

• Keyboard hotkey commands

• Manual selection buttons on the front panel

The OSD is also used to adjust various settings.

The illuminated LED of the top row of LEDs identifies which computer is currently selected.

To switch to the next computer, press and release the [Shift] key, then press the [+] key.

To switch to the previous computer, press and release the [Shift] key, then press the [-] key.

Note! You can use the [+] key of the alphanumeric section or of the numeric keypad on

a US English keyboard. With a Non-US English keyboard, use the [+] key of the 

numeric keypad only. 

Installation (continued)

Cascading NetCommander KVM Switches

Basic Operation

Keyboard Hotkeys

Operation

SIU = Server Interface Unit
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Operation (continued)

To invoke the OSD: 

Press and release the [Shift] key twice. The OSD Main window appears. See Figure 9. Lines

with blue text show active computers. Lines with grey text show inactive computers.

The Type column indicates whether a computer “C” or another KVM switch “S” is 

connected to the port.

Figure 9 The OSD Main Window

Navigating the OSD

To move up and down, use the [ �� ] and [ �� ] arrow keys.

To jump from one column to the next (when relevant), use the [Tab] key.

To exit the OSD or to return to the previous OSD window, press [Esc].

Selecting a Computer

To select a computer:

1. Move to the desired computer line. 

2. Press [Enter]. The selected computer will be accessed. A confirmation label appears to 

show which computer is selected.

Note: While the OSD is activated, you cannot use the front panel “Select” buttons or the 

keyboard hotkeys to connect to a computer.

OSD Settings (F2)

Press [F2] to open the OSD Settings window (see Figure 10). 

Figure 10 The Settings Window

Note: If the OSD is password protected, only the Administrator will be able to get access to

the F2 settings window by using the appropriate password.

On-Screen Display
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Operation (continued)

General Settings

With the highlight line on the word GENERAL, press [Enter]. The General Settings window

appears (see Figure 11).

Figure 11 The General Settings window

From this screen you can do the following:

Security

The OSD offers an advanced password security system made up of three different security

levels. Each security level has its own access rights.

These levels are as follows:

Administrator (Status A) 

The Administrator can:

• Set and modify all Passwords and security profiles

• Get full access to any computer

• Use all OSD functions

Supervisor (Status S) 

The Supervisor can:

• Get full access to any computer

• Access the following OSD functions:

- F4 Scan, F5 Tune and F6 Moving the Confirmation label

User (Status U) 

You can set up six different Users in the KVM system. Each User has its own Profile set by

the Administrator, which defines the access level to different computers. There are three 

different access levels.

Activating Password Protection

The factory default setting for the OSD access is to have it not password protected. Only the

Administrator can password-protect the OSD or disable it. 

To password protect the OSD:

1. Go to the Security line in the General Settings window. 

2. Toggle between Security On and Off using the space bar. 

3. Type the Administrator's password (default is "admin") into the Password Box and 

Press [Enter].

4. The new security status is set.
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Operation (continued)

F7 Defaults

Changing the OSD hotkey

By pressing [Shift], [Shift] the OSD appears. You can replace [Shift], [Shift] with any of the

following:

• [Ctrl], [Ctrl]

• [Ctrl], [F11]

• [Print Screen]

To change the hotkey:

1. Navigate to the Hotkey line.

2. Press the [Space] bar to toggle between options. To display the OSD in the 

future, press the new hotkey.

Autoskip

With the Autoskip feature set, the arrow keys will only access the active computer lines on

the OSD. When Autoskip is Off, the arrow keys will access both active and inactive 

computer lines.

To change the Autoskip setting:

1. Navigate to the Autoskip line.

2. Toggle between the options using the Space bar.

Serial port

The Serial port is used for the Firmware upgrade. Serial port On means the program can be

used.

To change the Serial port setting:

1. Navigate to the Serial port line.

2. Toggle between the options using the Space bar.

Changing the Keyboard language 

The keyboard is preset to US English.  It can be changed to French (FR) or German (DE) by

doing the following:

1. Navigate to the Keyboard language line. 

2. Toggle between the options using the Space bar.

Editing the Switch name

You can name a switch using a character string up to 18 characters long. A space constitutes

a character. When there is more than one switch in the system, give each switch's OSD a 

different name.

Press F7 to return the OSD to the factory default settings. Note: All changes that have been

made will be removed.
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Operation (continued)

Ports Settings

In the Settings window, go to the Ports line and press [Enter]. The Ports settings window

opens (see Figure 12).

Figure 12 Ports Settings window

Editing the computer name

Use this window to edit the computer names (maximum of 15 characters). 

To erase a character:

Select it and press the [Space bar]. Blank spaces remain in place of the erased character.

To erase an entire line:

Place the cursor at the beginning of the line. Keep the [Space bar] depressed until the line is

erased.

Keyboard (KB)

The KVM operates with Windows, Linux, HP UX, Alpha UNIX SGI, DOS, Novell, MAC,

USB or Open VMS.

By default the keyboard mode is set to PS for Intel based computers. 

For the other systems set the KB column as follows:

• U1 for HP UX

• U2 for Alpha UNIX, SGI, Open VMS

Adding/changing a hotkey (HKEY)

Cascade the KVM by connecting another KVM Switch to a Computer port instead of a 

computer, and then connecting more Server Interface Units to the second Switch. Connect a

third and fourth Switch in the same way. With the KVM 16 Port model, connect up to 256

computers through cascading.

You will need to define a hotkey to display the OSD of each Switch. These hotkeys must be

different for the top and bottom layers. The hotkeys can be any of the choices as set out 

previously. 

To add/change a hotkey:

1. On the line to which the Switch is connected, press Tab to jump to the HKEY column.

2. Toggle between the options using the Space bar.

200512060 93-2520 B072 series OM.qxd  3/6/2006  11:17 AM  Page 12

Download from Www.Somanuals.com. All Manuals Search And Download.



13

Operation (continued)

Time Settings

In the Settings window navigate to the Time line and press [Enter]. The Time settings 

window appears )see Figure 13).

Figure 13 Time settings window

Scan (SCN) - Label (LBL) - Time out (T/O)

SCN - Sets the scan period. 

LBL - Sets the amount of time the OSD label that show which computer is currently

accessed is displayed.

T/O - When password protection is activated, you can automatically disable the keyboard,

mouse and screen after a set amount of idle time. 

To set the above periods:

1. On the desired line press Tab to jump to the desired column. 

2. Place the cursor over one of the 3 digits and type a new number. Enter a leading zero 

where necessary. For example, type 030 for 30 seconds.

Enter 999 in the LBL column to have the label displayed continuously. Enter 000 if you 

do not want the label to appear.

Enter 999 in the T/O column to disable the Timeout function. 

Enter 000 if you want the Timeout function to work immediately. (WARNING: we 

suggest a minimum time of no less than 005 seconds as 000 causes the timeout function 

to work immediately.) 

Enter 999 in the SCN column to display the screen for 999 seconds. 

Enter 000 to skip the computer screen.

Users

In the Settings window navigate to the Users line and press [Enter]. The Users settings 

window appears (see Figure 14).

Figure 14 The Users Settings Window
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Operation (continued)

There are three different access levels. These are:

• Y - Full access to a particular computer. Plus access to the F4, F5 and F6 OSD functions

• V -View access only, to a particular computer (No keyboard/mouse functionality)

• N - No access to a particular computer - A TIMEOUT label appears if access is attempted

To give each user the desired access level:

1. Navigate to the desired computer line and User.

2. Toggle between the options using the Space bar.

Security

Go to the Security line in the Settings window and press [Enter]. The Security settings 

window appears (see Figure 15).

Figure 15 The Security settings window

The “T” column on the right hand side refers to the Type of password. 

There can only be 1 Administrator password, 1 Supervisor password, and 6 User passwords.

To change a user name or password:

1. Move to the desired line and column.

2. Type a new user name / password. User authentication is done solely via the password, 

there is no security significance to the names.

The factory default setting for the User Profile Settings is full access.

OSD HELP Window (F1)

To access the HELP window press [F1]. The HELP window is displayed (see Figure 16).

Figure 16 The HELP window

Please note! All the functions in the Help window are performed from the Main window. The

Help window is only a reminder of the hotkeys and their functions.
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Operation (continued)

You can adjust the scan time in the Time Settings window (see Figure 13).

To activate scanning:

1. Press the [Shift] key twice to activate the OSD.

2. Press the [F4] key. 

Each active computer will be displayed in sequence. A Scan label appears in the top left corner.

To deactivate scanning: 

Press [F4].

Tuning (F5)

You can tune the image of any remote computer screen.

To adjust the screen image:

1. Move to the remote computer you want to adjust.

2. Press the [F5] key. The screen image of the selected computer is displayed, along with 

the Image Tuning label.

3. Adjust the image by using the Right and Left Arrow keys.

4. When the image is satisfactory, press [Esc].

Note! Distance affects picture quality. The further away a remote computer is from the

KVM, the lower the image quality and the more tuning needed. Therefore put any 

higher resolution computers closer to the KVM.

Scanning Computers (F4)

Moving the Label (F6)

You can position the OSD label anywhere on the screen.

To position the label from the Main window:

1. Move to the desired computer using the Up and Down Arrow keys.

2. Press the [F6] key. The selected screen image and Identification label are displayed.

3. Use the arrow keys to move the label to the desired position.

4. Press [Esc] to save and exit.

200512060 93-2520 B072 series OM.qxd  3/6/2006  11:17 AM  Page 15

Download from Www.Somanuals.com. All Manuals Search And Download.



16

Software

With the NetCommander KVM Update software program you can upgrade the firmware for

the:

• OSD

• Manager

• Server Interface Units

KVM Update enables you to add new features and take advantage of product improvements

in a quick and efficient manner.

You can install the KVM Switch Update on any computer, even one not part of the KVM

system.

Upgrading the KVM Firmware

• Pentium 166 or higher with 16MB RAM and 10MB free Hard Drive space

• Free Serial port

• Windows 98 and later

To update the firmware the KVM system must be connected and switched on

To run the software, connect the RS232 Serial cable to the computer containing the software,

and to the KVM Switch.

Connecting the RS232 Serial Cable

To install the KVM Switch Update software:

1. Download KVM update software from www.tripplite.com

2. Run the software.

Installing the Software 

System Requirements
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Software (continued)

1. Start the KVM Update software. The KVM Update window appears (see Figure 17).

Starting and Configuring the KVM Update

Figure 17 The KVM Switch Update window

The table below explains the functions of the buttons and boxes in the KVM Switch Update

window.

2. From the Options menu choose Com Port. The Com Port box appears (see Figure 18).

Figure 18 The Com Option box
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Software (continued)

3. Choose an available Com Port and click OK.

Note! The RS232 Serial cable must be connected to the selected Serial port.

Before upgrading the firmware, you must first verify which firmware and hardware versions

you have. 

The OSD version number

To verify the OSD version number:

1. Open the KVM Switch Update program. 

2. In the Switch Unit box, check the OSD option. See Figure 17.

3. Click . The version number appears in the Switch box. 

The H/W Version button is grayed out, as there is no hardware relevant to the OSD.

The KVM Manager version number

To verify the KVM version number:

1. Open the KVM Switch Update program. 

2. In the Switch Unit box, check the KVM Manager option.

3. Click . The firmware version number appears in the Switch Unit box.

4. Click . The hardware version number appears in the Switch Unit box.

Verifying the Server Interface Unit's version number

Before you can check a Server Interface Unit, you must uncheck the Switch Unit box

options.

To verify the Server Interface Unit version number:

1. Open the KVM Switch Update program. 

2. Check one or more or all of the Server Interface Units.

3. Click . The firmware version number appears after the Server Interface 

Unit number.

4. Click . The hardware version number appears after the Server Interface 

Unit number.

When “Not responding” appears, no computer is connected, or it is switched off.

Verifying the Version Numbers

Download the latest firmware for your system from www.tripplite.com

Obtaining New Firmware

Warning! Never switch off any computer connected to the KVM system during the

updating process.

To update the firmware:

1. Open the KVM Switch Update program. 

Updating the Firmware
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Software (continued)

2. In the KVM Switch Update window, check the appropriate option in the Switch Unit 

box or the desired Server Interface Unit.

3. From the File menu, choose Open. The Open box appears (see Figure 19).

4. Navigate to the folder that contains the firmware update file. You may only see the files 

that match the file selection mask.

Figure 19 The Open box

5. Open the file.

6. Click Start. The KVM Switch Update flashes the firmware. On completion the 

firmware version number appears.

7. Check that the updated version number is correct by pressing .

Firmware Update generates one log file per session that displays a chronological list of

actions. You can read the log file in any ASCII text editor. The log file is located in the

Windows directory.

Reset the software for the KVM Manager or Server Interface Units when for example the

unit hangs or when the mouse fails to work properly. Resetting is done via the Serial port,

and avoids the need to shut down the computer.

NOTE! The Reset function does not affect the parameters of the unit settings.

Resetting the Switch or Server Interface Units

To reset the Switch or Server Interface Unit units: 

1. For the Switch, check the KVM Switch option in the Switch Unit box. 

For the Server Interface Units, check one or more Server Interface Units in the Server

Interface Units box.

2. From the Options menu choose Advanced / Reset. The units reset. The system should 

now be operational.

Reset
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When using Firmware Update software you may at times get a Communication Error 

message.

If a Communication Error message does appear during the update procedure, do the following:

1. Ensure that the RS232 Serial cable's RS232 connector is connected to the Switch's 

Communication port.

2. Ensure that the RS232 Serial cable's DB9F connector is connected to the DB9M Serial 

port on the CPU's rear panel.

3. Restart the download process.

Electricity failure 

If the electricity fails during an update to the KVM firmware, do the following:

If the electricity fails while the switch firmware is updating, a Communication Error message

will appear. Simply resume the firmware update by opening the folder that contains the

firmware update file and continue from there.

If the electricity fails while the Server Interface Unit firmware is updating, a 

Not Responding or Upgrade Error message will appear. Restart the upgrade from the

beginning.

Troubleshooting

USB/SUN Combo Keys

The connected PS/2 keyboard does not have a special SUN keypad to perform special 

functions in the SUN Operating System environment.  So when a RICC USB or SUN is 

connected to a SUN computer, the RICC emulates these SUN keys using a set of key 

combinations called Combo keys. See the table below.

SUN key Combo key

Stop Left Ctrl + Alt + F1

Props Left Ctrl + Alt + F3

Front Left Ctrl + Alt + F5

Open Left Ctrl + Alt + F7

Find Left Ctrl + Alt + F9

Again Left Ctrl + Alt + F2

Undo Left Ctrl + Alt + F4

Copy Left Ctrl + Alt + F6

Paste Left Ctrl + Alt + F8

Cut Left Ctrl + Alt + F10

Help Left Ctrl + Alt + F11

SUN key Combo key

Compose Application key or 

Left Ctrl + Alt + Keypad *

Crescent Scroll Lock

Volume Up Left Ctrl + Alt + Keypad -

Volume Down Left Ctrl + Alt + Keypad +

Mute Left Ctrl + Alt + F12

Sun Left key Left Windows key

Sun Right key Right Windows key

Alt-Graph Right Alt or Alt Gr

Stop A Left Ctrl + Alt + 1
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Specifications
Operating Systems DOS, Windows (3X, 9X, 2000, NT4, ME, XP, 2003 Server) 

LINUX, UNIX, QNX, SGI, FreeBSD, BeOS, Open VMS, 
Novell 3.12-6, Alpha UNIX, HP UX, SUN

Mouse PS/2, Wheel mouse, Intellimouse, 5-button mouse

Resolution 1600x1200@75Hz

Transmission distance Up to 33 ft.

NetCommander 
KVM Switch Models B072-016-1 or B072-008-1

Dimensions - 8/16 port 17” x 5’ x 1.7”

Weight - 8/16 port Product - 3.5 lbs.
Shipping - 5.5 lbs.

Power supply Internal switching 85-260 VAC 50 / 60 Hz

Connections

System RJ45

Serial RJ11

Monitor HD15

Keyboard MinDin6

Mouse MiniDin6

Operating / Recommended 
ambient temperature 32°F to 104°F

Storage temperature -40°F to 158°F

Humidity 80% non-condensing relative humidity

NetCommander Server 
Interface Units Model B078-001-PS2 Model B078-001-USB

Connections

VGA HD15 HD15

Keyboard/Mouse MiniDin6 USB

System RJ45 RJ45

Power From Keyboard port From USB port

Note: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part

15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the

equipment is operated in a commercial environment. This equipment generates, uses and can radiate radio frequency

energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio

communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case

the user will be required to correct the interference at his own expense. The user must use shielded cables and 

connectors with this product. Any changes or modifications to this product not expressly approved by the party 

responsible for compliance could void the user's authority to operate the equipment.

FCC Radio/TV Interference Notice
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1-Year Limited Warranty
TRIPP LITE warrants its products to be free from defects in materials and workmanship for a period of one (1) year

from the date of initial purchase. TRIPP LITE's obligation under this warranty is limited to repairing or replacing (at its

sole option) any such defective products. To obtain service under this warranty, you must obtain a Returned Material

Authorization (RMA) number from TRIPP LITE or an authorized TRIPP LITE service center. Products must be

returned to TRIPP LITE or an authorized TRIPP LITE service center with transportation charges prepaid and must be

accompanied by a brief description of the problem encountered and proof of date and place of purchase. This warranty

does not apply to equipment, which has been damaged by accident, negligence or misapplication or has been altered or

modified in any way. 

EXCEPT AS PROVIDED HEREIN, TRIPP LITE MAKES NO WARRANTIES, EXPRESS OR IMPLIED, 

INCLUDING WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. Some

states do not permit limitation or exclusion of implied warranties; therefore, the aforesaid limitation(s) or exclusion(s)

may not apply to the purchaser. 

EXCEPT AS PROVIDED ABOVE, IN NO EVENT WILL TRIPP LITE BE LIABLE FOR DIRECT, INDIRECT, 

SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OF THIS PRODUCT,

EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. Specifically, TRIPP LITE is not liable for any

costs, such as lost profits or revenue, loss of equipment, loss of use of equipment, loss of software, loss of data, costs of

substitutes, claims by third parties, or otherwise.

Visit www.tripplite.com/warranty today to register the warranty for your new Tripp Lite product. You'll be automatically

entered into a drawing for a chance to win a FREE Tripp Lite product!* 

* No purchase necessary. Void where prohibited. Some restrictions apply. See website for details. 

This product is designed and engineered in the USA. 

The policy of TRIPP LITE is one of continuous improvement. Specifications are subject to change without notice. 

Warranty Registration 
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Tripp Lite World Headquarters
1111 W. 35th Street, Chicago, IL 60609 USA

(773) 869-1234, www.tripplite.com
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